
New
Create a new image in the iPhoto Express workspace to edit or paint. 
(Hot Key -- Ctrl+N)



Open
Open a dialog box for selecting previously saved images to open in iPhoto Express.
(Hot Key -- Ctrl+O)

Opening Images 



Close
Close the active window without ending the program. iPhoto Express prompts you to save changes to the image.
(Hot Key -- Ctrl+W)



Save
Save your work as a new image file or overwrite an existing one.

Save saves the file with its existing name and format. If the file has no name the Save As dialog box opens 
so you can assign one. 

(Hot Key -- Ctrl+S)
Save As Opens the Save As dialog box where you can assign a name, format, and location.



Acquire
Shows a submenu for using a TWAIN compatible capture device. Use these commands to import printed 
photographs or other images into iPhoto Express.

Image Use the selected capturing device to capture and send the captured image to a specified destination.
Select Source Choose which scanning device to use if more than one is connected to your system.
Troubleshooting Obtain advice to help you use a scanner or digital camera.



Preferences
Set default settings for working on images in iPhoto Express and optimizing performance.
(Hot Key -- F6)



Open Template File
Create greeting cards, business cards, invitations, postcards, and other fantastic items using a sample template as a 
starting point for your project. iPhoto Express Explorer provides you a visual search facility for finding the desired 
template.



Export
Shows commands added to iPhoto Express by Adobe Photoshop compatible or other Export plug-in modules. These 
types of modules might allow you to use additional equipment, such as video capture devices or non-TWAIN digital 
cameras with iPhoto Express. They can also offer additional file format support or saving options for your images 
after you finish editing them.



Copier
Scan directly to your printer. As soon as you click copy, your scanner’s dialog box opens. When you close the dialog 
box, your scanner starts and your printer prints out the results immediately.



Fax
Send a fax directly from your scanner. When you click Fax, your scanner’s dialog box opens where you can set your 
scanning settings. As soon as you complete setting the scan settings, your fax-modem’s fax dialog box opens where 
you can specify the phone number and any other options your program offers.



Print    
Send the active image to the currently selected printer for output.
(Hot Key -- Ctrl+P)



Print Preview    
See approximately how the image will appear on a page before you actually print it out. A submenu offers three 
options:

Normal The standard print preview for printing a single copy of the image out on a sheet of paper.
Tile A preview mode that allows you to print multiple copies of the same image on a sheet of paper. This is 

good for place cards, business cards, and other wallet-sized printouts.
Poster A preview mode best suited for very large images that require more than one sheet of paper to print.



Print Setup
Change and set your output device settings, (usually a printer), according to your needs.



Send
Write and send electronic mail messages to an installed e-mail system and attach images to the messages.



Exit
End the current iPhoto Express session, closing all images. If you made any changes to open images and have not 
saved them yet, iPhoto Express prompts you to save them first.
(Hot Key -- Ctrl+Q)



Recently Opened Files
Shows up to the last nine images opened in iPhoto Express. Clicking on a name in this list opens the image in the 
workspace.

Note: You can set the maximum number of file names shown with the "Number of recently opened files" option in the 
iPhoto Express tab of the Preferences dialog box.



Undo Before / Redo To    
Undo Before shows a submenu of up to the last 5 actions you performed that can be reversed. iPhoto 

Express reverses all actions above and including the one you choose.
(In the task bar) Undoes your last action only. 

(Hot Key -- Ctrl+Z)
Redo To shows a submenu of all actions you have undone. iPhoto Express re-applies all actions above and 

including the one you choose.
(In the task bar) Reapplies your last undo.

(Hot Key -- Ctrl+Y)

Note: You can set the maximum number of steps shown in the Undo and Redo submenus by changing the "Level of 
undo" settings in the iPhoto Express tab of the Preferences dialog box.



Cut    
Remove the selected area and place it on the clipboard. iPhoto Express fills the empty space with the current 
background color. If nothing is selected, the entire image is cut.
(Hot Key -- Ctrl+X)



Copy    
Copy the selected area to the clipboard without removing it from the active window.
(Hot Key -- Ctrl+C)



Paste
Place the image on the clipboard into the current image. Depending on the current image’s size and status, the 
pasted image can appear one of three ways:

If a selection area exists the pasted image appears starting from the top left corner of 
the selection. You may then drag the pasted image anywhere inside the selection.

If no selection exists and the target image has the same dimensions as the image 
the source image, the pasted image appears in the same location in the target image that it was in the source 
image. You may then drag the pasted image to any other location.

If no selection exists and the source and target images are of different dimensions, 
the pasted image appears starting from the top left corner of the target image. You may then drag the pasted image 
to any other location.
(Hot Key -- Ctrl+V)



Clear
Permanently remove the selected area from the active window, filling the space with the background color. Use this 
command to delete information without affecting the clipboard. If nothing is selected, iPhoto Express replaces the 
entire image with the current background color.
(Hot Key -- Del)

Deleting data 



Select
Accesses a submenu for creating and changing selection areas without the mouse. Some things you can do include 
selecting or deselecting the entire image, switching the selected and unselected parts of an image, using an existing 
selection as the basis for a new one, and softening edges of a selection area.



Select None
Deselect all selected areas in the image.



Select All
Select the entire image.



Select Invert
Select all unselected areas while deselecting all selected areas in the image.



Make Floating
Create an object out of the current selection. This allows you to move the image in the selection without affecting the 
base image.



Merge
Affix the selected floating image to the base image. Once merged, it may be very difficult to re-select that portion of 
the image.



Properties
Open the Floating Properties dialog box for reviewing and changing the properties for the selected floating image, 
such as transparency and edge blending. This allows you to control how the floating image will blend into the base 
when you merge it.



Crop
Trim the unselected area from the image. 

If nothing is selected control handles appear over the image. Drag them to surround the portion you wish to keep and 
double click. iPhoto Express trims away all portions of the image outside the handles.
(Hot Key -- Ctrl+R)



Fill
Open a dialog box with choices for filling the selected area with a color, texture or clipboard data. If nothing is 
selected, the entire image will be filled.
(Hot Key -- Ctrl+F)



Stitch
Create a new image by connecting two images together. A dialog box offers you controls for combining the images.



Rotate & Flip 
Shows a submenu for changing the orientation of an image.

Rotate Left 90 Turn the image counterclockwise by 90º.
Rotate Right 90 Turn the image clockwise by 90º.
Rotate 180 Turn the image upside down.
Flip Horizontally Create a mirror image using the vertical axis as the reference.
Flip Vertically Create a mirror image using the horizontal axis as the reference.
Rotate Freely Use your mouse to drag a handle of the selected image to rotate it.



Free Resize
Use your mouse to resize the selection. iPhoto Express places handles at the edges of the selection for you to drag. 
If nothing is selected, the handles appear at the edge of the entire image.



Zoom In / Zoom Out
Increase or reduce the magnification of the image on screen. This gives you an opportunity to gain finer control over 
your image editing.



Fit In Window / Fit In Window by
Resize the current image on screen to fit the largest window that can be displayed in the workspace. This does not 
change the image or any of its attributes.



Full Screen
Hide the iPhoto Express and Windows interface, filling the screen with the current image. This enables you to edit or 
view an image without the distractions of other open windows or programs. To return to Windows, press Escape.
(Hot Key -- Ctrl+U)



Photo Properties
Open the Properties dialog box with statistics about the current image. This dialog box has two major sections:

Attributes shows the data type, image and file size, and resolution.
File shows the name, format, compression method, and other information about the file.

Hot Key -- Alt-Enter



Actual View
Resize the image to 1x magnification.



Lighting
Fine tune the brightness and contrast in the image. The Lighting dialog box offers slider controls and thumbnail 
previews for fine tuning the image to perfection.
(Hot Key -- Ctrl+B)



Color Balance
Enhance the dynamic range of your image by shifting the neutral shades in your image. By shifting the neutral 
shades lower, you can show more subtle changes in the primary colors, (Red, Green, Blue). By shifting the shades 
higher, you enhance their compliments, (Cyan, Magenta, Yellow).
(Hot Key -- Ctrl+L)



Hue & Saturation
Shift the colors in an image. Changing the hue affects color. Changing the saturation makes the colors more intense 
or washed out.



Focus
Make the image appear sharper or more blurry.
(Hot Key -- F7)



Black & White
Convert the selected image to black and white. This might be useful if space is a real problem and you only intend to 
print the image using a low-end black and white printer.



Grayscale
Convert the selected image to grayscale. This is good for images that are intended to be printed in black and white 
only, such as in a book, magazine, or report where color printing is either unnecessary or too expensive.



Indexed 16-Color
Convert the selected image to indexed 16-Color. This is a good way to reduce file size for images only using a few 
colors.



Indexed 256-Color
Convert the selected image to indexed 256-Color. This might be useful if you are preparing the image for displaying 
on other people’s computers.



True Color
Convert the selected image to True Color. This gives you the greatest control over editing your images.



Resize
Open the Resize dialog box where you can make your image bigger or smaller. There are two ways to change your 
image size. Each has its own advantages and disadvantages:

Changing the Size (dimensions) By changing the size of your image, you actually alter 
data. Making an image smaller with this method makes the file size smaller, Making the image bigger makes the file 
bigger. Also, you actually change how your image appears. This means making an image smaller will destroy some of
your original image data to fit in the new size. Making the image bigger causes iPhoto Express to interpolate your 
image data to make a good “guess” as to what colored pixels to add to the image to fill the extra space.

Changing the Density (resolution) By changing the density of the dots (pixels) in your 
image, the only thing that changes is the size and proximity of each pixel when printed out. Actual file size remains 
the same because the total number of pixels in the image does not change. Increasing the density makes the printed 
image smaller as the dots are smaller and closer together; reducing makes it bigger. You will not notice any change to
your image when you view it on-screen after changing the density because your monitor cannot change the size and 
proximity of the dots it displays.
(Hot Key -- Ctrl+G)



Cascade
Arrange all open images diagonally in the workspace from left to right and top to bottom.
(Hot Key -- Shift+F5)



Tile Horizontally & Tile Vertically
Evenly distribute all open images in the workspace.
(Tile Vertically Hot Key -- Shift+F4)



Arrange Icons
Arrange icons for all minimized images in the workspace neatly along the bottom of the workspace.



Show / Hide Effect Palette
Shows or hides the Effect Palette allowing you to apply special effects using visual samples instead of filter names or 
giving you more room in the workspace for viewing and editing your image.

Effect Palette Effects 
 Effect Palette 



iPhoto Express Help
Open the Help Contents dialog box for this help file.



Ulead Products Tour
Open the About Ulead help, providing insight into Ulead Systems and its products.



Photo Capture Tour
Starts a short interactive tour and tutorial about using scanners, digital cameras, and other tools to bring images and 
photographs into iPhoto Express.



iPhoto Express Tour
Starts a short interactive tour of iPhoto Express to help you see what you can do and how easy it is with iPhoto 
Express.



Photo Capture Troubleshooting
Starts the Scanner Help which gives you step by step guidance on how to achieve the best results with your scanner 
and fix minor problems you might encounter.



New dialog box
The New dialog box provides you with choices for deciding what kind of image you want to create. Besides picking 
from a list of standard image sizes, you can specify your own custom size and limit how many colors the image can 
have. 

Data type Click the button identifying the desired color characteristics for the new image.

    Black and White

    Grayscale

    16-Color

    256-Color

    True Color
Canvas The color square shows the color for the background of your new image. Click 

the square to select a different color. 
Width and Height Select or enter the desired size for the image.    
Resolution Set the density of the pixels in the image. If your image is intended for showing on-screen only, 

the default, 72 dpi, is good enough. If you intend to print the image, you might consider increasing the resolution.
Memory size This shows how much space is the new image will occupy on your hard disk when saved 

without compression. 
Preview Select Printer to see how big the image would be when printed using your 

current printer settings. Select Screen to see how large the image would be on your screen at 1x magnification.



If the image size is user defined and the unit of measure is pixels, this affects the overall size of the image when 
printed.

Remember that the increasing the resolution of an image while maintaining the physical dimensions affects the file 
size. For example, an uncompressed 3 × 5-inch True Color image at 72 dpi is 3420 bytes. At twice the resolution (144
dpi) the same size image will be 6480 bytes, (twice the size).



Standard Choose a size from the drop-down list of common sizes for digital video and 
computer displays.

Active image Create a new image the same size as the current image.
User defined Set the size of the width, height, and unit of measure for a new image 

according to your own specifications.



Frame & Shadow dialog box
Applies a border, background, and shadow to the base image.

Frame Check to include a frame around the entire image. Then specify the width and 
color or pattern for the frame. (The border immediately surrounds the image.) You may choose any of these types of 
frames for the image:

Color The frame color or texture will match that of this square. To choose a different color 
or texture, right click on the color square and choose the desired command for selecting a new one.

Shadow Check to include a shadow around two edges of the frame. Choose the size and 
color of a shadow to go around the border.

Color and Direction The shadow color will match that of this square. To choose a 
different color, right click on the color square and choose the desired command for selecting a new color. Then select 
the option that shows a shadow in the direction you want.

X and Y offset Set the size, in pixels of the shadow. (X is horizontal, Y is vertical.)
Transparency Set a higher value to allow more of the underlying image to appear through the shadow. 
Edge blending Set a higher value to have the shadow blend into the background more smoothly.

Preview window Shows an example of how the background, border, and shadow will 
appear.



Resize dialog box
    Size
    Density

Resizes an image based upon the number of pixels it contains. Changing image size in this tab alters data. Making 
images smaller results in lost information and smaller file sizes. Making them bigger adds information and the file size
increases.

Standard Choose a predefined size for the image.
User defined Select to specify your own size for the image.
Print preview Shows how the image will appear on a printed page.
Active image Shows the current image size.
Memory used Shows the uncompressed file size for the new image.
Current printer Shows the currently selected printing device for outputting images.
Printer Click to change or configure the printing device.



Resize dialog box
    Size
    Density

Change the size of an image by changing the size and distance between the centers of the pixels. Unlike changing 
the sizes, changing the density always affects the entire image and no image data changes so the file size remains 
the same.

Display Select to use the current display resolution for your image.
Printer Select to use the currently selected printer’s resolution for the image.
User defined Specify the desired resolution in pixels per inch.
Active image Shows the current image size.
Print preview Shows how the image will appear on a printed page.
Memory used Shows the uncompressed file size for the new image.
Current printer Shows the currently selected printing device for outputting images.
Printer Click to change or configure the printing device.



Fill dialog box
Fills the selected image or mask with a pattern or image according to the following choices:

Selected color or texture The fill will match that of this square. To choose a different 
color or texture, right click on the color square and choose the desired command for selecting a new one.

Black Select to fill the selection with black.
White Select to fill the selection with white.
Clipboard data Select to fill the selection with the current clipboard data. (Only available if

the clipboard contains image data.)
Transparency Set a higher value to make the fill more transparent. This allows the 

underlying image to show through more clearly.
Preview See how the changes will affect the actual image before applying them.



Replace Photo dialog box
The Replace Photo dialog box appears every time you insert a photo that is not the same size as the template frame 
you are placing it into. It gives you choices on how the image should be resized. After you place the image, you may 
drag it within the frame so that the portion you wish to include appears properly.

Fit by width and height Select this to resize the width and height of the image 
independently. This will give you the best fit, but may distort your image.

Fit by width Select this to resize the image proportionally based on its width. Depending 
on the height of your image, there may be some empty space in the frame above or below it or parts of it may be cut 
off.

Fit by height Select this to resize the image proportionally based on its height. Depending
on the width of your image, there may be some empty space in the frame on either side of it or parts of it may be cut 
off.

Keep the original size Select this to insert the image without resizing it. If the image is 
larger than the frame, parts of it may be cut off. If the image is smaller, empty space will surround the image in the 
frame.

Preview Click to see how your photo will look when inserted into the selected placeholder 
before actually accepting the current dialog box setting.



Gradient Fill dialog box
The Gradient Fill dialog box offers you choices for selecting colors for gradient fills and how to apply them to text. 

Fill type Press the button that best illustrates how you wish the fill to progress.
Colors These squares identify the starting and ending colors for the fill. To choose a 

different color or texture, right click on the color square and choose the desired command for selecting a new one.
Transpose button Click this to switch the positions of the two selected colors.



Color Balance dialog box
Shift the colors in your image towards or away from the primary colors of Red, Green, and Blue.

Preview images Show thumbnail views of the image you wish to adjust and how it 
changes.

Real-time preview Check to instantly show changes in the actual image. Even though 
they appear in the image, the change is not applied until you click OK.

Color sliders Slide to the right to add more of that slider’s color.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview 

window.
Reset Click to restore the image to the condition it was in when you clicked the Color 

Balance command.



Red Sliding to the right makes the image redder. To the left shifts the image towards cyan.
Green Sliding to the right makes the image greener. To the left shifts the image towards 

purple.
Blue Sliding to the right makes the image bluer. To the left shifts the image towards 

yellow.



Lighting dialog box
Makes an image lighter or darker and allows you to make parts of it stand out or blend in more.

Preview images Show thumbnail views of the image you wish to adjust and how it 
changes.

Real-time preview Check to instantly show changes in the actual image. The change is 
not officially applied until you click OK.

Brightness Choose higher values to produce a brighter image.
Contrast Slide to the right to make lighter and darker areas stand out more. Slide to the 

left to fade the image.
Gamma Slide to the right to make the image lighter and emphasize the main color 

components in the image.
Preview Click to see how the changes affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview 

window.
Reset Returns all dialog box settings to the conditions they were in when the dialog box 

opened.



Focus dialog box
Make your image look sharper or fuzzier.

Auto-adjust Check to have iPhoto Express determine the best settings for sharpening the
image or selection automatically.

Blur - Sharpen Set a higher value to make borders and edges stand out. Set a low value 
to soften edges and make edges blend into each other.

Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview 

window.



Eyedropper dialog box
Select a color based on an existing pixel in the selected image.

Sample image Click in this image to select a new color
Zoom in Increase the magnification of the sample image by 1.
Zoom out Reduce the magnification of the image by one.
1x Change the magnification of the image to the actual size.
Fit Change the magnification to the largest that will fit in the Sample Image area.

Color block Shows the color under the mouse pointer. 



Add Shadow dialog box
Define the properties of a shadow object to group with the currently selected object.

Direction Choose the direction for the shadow to fall.
X and Y offset Set the size in pixels for the shadow.
Transparency Set a high value to allow more of the base image to show through the 

shadow.
Edge blending Set a higher value to blend the shadow more smoothly into the 

background. Make sure that the width does not exceed the width or height of the object group.
Color Click the color square to choose a color for the shadow.
Preview Click to see how the shadow appears before applying it to the object.



Stitch dialog box
The stitch dialog box enables you to combine two images to create a single, larger image. This is especially useful if 
you cannot scan your entire image into the computer in one try. Do two or more tries, including a small overlapping 
section in each scan and then stitch the images together.

Stitch with Select the image to attach to the current one.
Overlap area transparency Make the image selected in the Select with option 

transparent where it overlaps. This may be useful for helping you find the best place to stitch. Set a higher value to 
allow more of the current image to show through areas covered by the selected image.

 Manually Check to stitch images based upon reference points you place in each image. 
In general, checking Auto fine-tune produces best results.

Note: You may also drag-and-drop the selected image to its desired location.
Auto stitch Check to have iPhoto Express determine the best stitch possible. (iPhoto 

Express compares images finding the areas of greatest similarity and stitches along those edges.) Set an overlap 
range to define the general region in the selected image where the original can be joined. Set the tolerance to 
determine how far iPhoto Express can shift the image to find the best match.

Test Click to preview the results in the working area before accepting.
Switch positions (left / right) Place the side by side or switch the left image with the right.
Switch positions (top / bottom) Place the images one over the other or switch the top image with the 

bottom.
 Deskew buttons Click horizontal ( 

 )to correct any misalignment for the stitched images horizontally, Click vertical ( 
 )to align them vertically. 

Zoom in Zoom in to obtain a clearer view of a small portion of the stitched images.
Zoom out Zoom out to gain a better view of all of both images.

Actual view Change the view so that both images appear at their actual sizes.
Fit in window Scale both images so that they both appear in the working area at the 

largest possible magnification.
Work area Position the two images by dragging them where you want.



Quick card
Use any of the wide variety of greeting card templates included with iPhoto Express to create your own unique 
fantastic looking greeting cards. iPhoto Express offers ideas for all occasions, including birthdays, holidays, special 
events, and invitations.



Calendar
Create a calendar using your favorite images as the centerpiece.



Namecard
Quickly print out more copies of previously saved name cards. (You can also use this QuickTask to quickly print other 
tileable images.)



Poster
Print out large images that span more than one page using your current printer. The Poster command allows you to 
split the image so that you can easily print the entire image and then assemble it.



Screen Art
Present your images for onscreen use. The Screen Art QuickTask offers you options for creating slide shows and 
screen savers using images on your hard disk. You can also select an image to use as your Windows Wallpaper. 

Note: iPhoto Express enhances how you can create wallpapers for Windows by offering advanced tiling and sizing 
options which allow your image to fill the screen more smoothly.



Scan
Use your currently selected scanner to scan an image directly into iPhoto Express. iPhoto Express immediately 
switches to the Adjust tab after scanning so you can begin enhancing your image.



Import
Place an image or photograph into iPhoto Express from a source other than your scanner or previously saved files. 
For example, if you own a digital camera, use the Import command to copy the photos it contains into iPhoto Express.



Paste as a New Image
Place image data that is currently on the Windows clipboard into iPhoto Express as a new image. This might be 
useful if you want to edit an image from a document in your word processing program.



Straighten
Automatically straighten an image according to dominant horizontal and vertical features in the image. This might be 
useful if your scanned photo comes out a little crooked.

Note: If the straighten command does not adequately correct a crooked image, try using Rotate Freely from the 
Rotate & Flip submenu in the Edit menu.



Rotate / Flip
Quickly flip or rotate your image using one of the four submenu commands offered by this task. This might be useful if
you scan a photo sideways or the wrong side of a slide.



Color
Adjusts the overall color of your image. This task offers two commands in its submenu:

Color Balance Allows you to enhance the dynamic range of your image by shifting the 
neutral shades in your image. By shifting the neutral shades lower, you can show more subtle changes in the primary 
colors, (Red, Green, Blue). By shifting the shades higher, you enhance their compliments, (Cyan, Magenta, Yellow).

Hue and Saturation Allows you to adjust shift the colors in an image. Changing the hue 
affects color. Changing the saturation makes the colors more intense or washed out.



Plug-in Commands
Magic Opens a submenu that contains special effect plug-ins. iPhoto Express comes with 

this special effect to get you started:
Turnpage Curl an edge of your image as if it is being peeled off a surface or a page from 

a book.
Camera Opens a sub menu that contains plug-ins that act as filters or corrections due to 

poor conditions during photography. iPhoto Express comes with this filter to get you started:
Remove RedEye Find unwanted reds in your image and shifts them towards a color you 

specify. This is particularly useful for eliminating “red eye” which often occurs during flash photography.
Import Opens a submenu that contains special tools enabling you to add new methods of 

opening images in iPhoto Express. This can be in the form of new file formats or equipment.
Video Camera Allows you to use a video capture card and video player, such as a VCR or

camcorder and hook it up to your video capture card as a source for images.
Export Opens a submenu containing commands that offer you different ways to save 

images:
Calendar Allows you to use an image as the focal point of a calendar page you create 

yourself.



Selection 
The Selection task offers you three ways to create selection areas for editing, moving, or deleting portions of your 
image. Each tool has its own set of tool options that appear along the bottom of the workspace.

Simple Shape Create a rectangular or circular selection. 

Lasso Draw your own selection of any shape or size. 

Magic Wand Create a selection based upon the colors that currently exist in your image.



Transform
The Transform task allows you to resize, rotate, and deform images. Its tool options appear along the bottom of the 
workspace and contain several items to help control the way you change the image dimensions. Click here       
to learn about its tool options.



Text
Add fancy words to your images with the Text task. The tool options that appear along the bottom of the workspace 
offer controls for changing the font, style, size, color, and shape of your letters. Click here        to learn about its
tool options.
To add text to the image, simply click on the image to open the Text Attribute dialog box. Note: You can type multiple 
lines of text into your image at one time by pressing the Ctrl key as you press Enter to add a carriage return.



Paint
The Paint task offers you ways to add and edit your image using specialized painting tools. Each tool provides you 
with unique methods of giving your images that special touch:

Clone This is a great tool for keeping a consistent background in your image while erasing unwanted 
elements. Its also good for “painting” in a new element instead of using the traditional cut and paste. 

Darken If you just want to make a small part of your image darker, use the Burn tool to paint over that area. 
This is similar to a technique photographers use in the darkroom to darken small parts of their photographs. 

Lighten If a small part of your image is too dark, use the Dodge tool to make it lighter. This is similar to a 
technique photographers use in the darkroom to brighten small parts of their photographs. 

Smudge Use the Smudge tool to smear part of your image. This might be useful if you want to de-
emphasize an edge in your image. 

Paintbrush This is the standard, no frills painting tool.

Airbrush To apply a dispersed color pattern to the image, use the Airbrush tool. The faster you move your 
mouse over the image, the more dispersed the pattern. 

Crayon Try the Crayon tool to draw on your image as if you were using a wax crayon.

Mark pen Use the Marking Pen tool to apply color as if you were using a magic marker. Depending on your 
settings, it can act as a highlight marker that allows the image below to show through or as a permanent marker that 
covers the base image. 

Erase To remove data from the image and replace it with a single color, use the Erase tool.

Bucket Fill If you wish to fill a large area with a solid color use the Fill tool. 

Gradient fill To fill an area with a range of colors, choose Gradient Fill. 



Effect Palette
Nothing adds pizzazz to your work more than a few well used special effects or filters. And that’s where the Effect 
Palette comes in. You’ll find a bunch of really neat preset filters that you can apply to you photo or selected areas to 
create unique effects. And if you want even more control, the Effect Palette menu contains a Modify command that 
allows you to custom set the filters according to your own needs too. 

The top of the Effect Palette has two buttons:
The Try button places a thumbnail view of your current image or selection into the Effect palette. That way, 

you can obtain an instant idea of how choosing a filter will affect your image.
The menu button contains extra commands to give you more control over the Effect Palette:

Apply Changes your image or selection according to the currently properties for the 
selected thumbnail.

Modify Properties and Apply Opens a dialog box where you can adjust the settings for 
the currently selected thumbnail.

Use Image as Thumbnail Allows you to select a portion of your image to use as the 
thumbnail image.

Reset Thumbnails Restores the thumbnail images in the Effect Palette to the default 
image. (iPhoto Express automatically does this every time you close the program.)

Tile Effect Palette Shows a submenu that allows you to choose how to rearrange your 
workspace to show your image and the Effect Palette at the same time.
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More
The More task shows a submenu with four other enhancements you can make to your image:

Standard Fill The Standard Fill command opens a dialog box where you can choose a 
color, texture, or image data that you previously placed on the clipboard to use as a fill. It is best used to tile an image
in your background.

Add Shadow This command is only available if you have an active floating selection. It 
allows you to add a shadow to the selection. Adding shadows adds dimension to your images.

Remove Shadow This command is only available if the currently selected floating 
selection has a shadow. It allows you to remove the shadow without affecting the rest of your image.

Add Frame and Shadow The Add Frame and Shadow command allows you to create a 
frame and around the entire image. This might be useful for adding finishing touches to your images after your other 
editing is complete. A well designed frame and shadow can often be the perfect complement to an image, bringing 
out its highlights to perfection.

Turnpage This is an extra special effect that allows you to give a corner of your image a 
curled look, as if it were being peeled off of a flat surface.



Effect Palette Effects
Here is a description of the effects you will find in the Effect Palette.

Cool applies a blue or cyan tint to the image.
Emboss Makes the image appear as if it were stamped or imprinted on a solid surface.
Fat stretches the center of the image towards the left and right edges, squeezing the outer

area.
Mosaic Breaks the image into tiles and uses the average color value for the pixels in each

tile for all pixels in that tile.
Ripple Produces an effect so that the image appears to be under a stream of water.
Sharpen Makes an image area appear more crisp.
Thin stretches the left and right edges of the image towards the middle, squeezing the 

inner area.
Tile Breaks the image into square tiles with background colored borders. You may choose

to separate the squares, creating an appearance of the image breaking apart.
Warm applies a red or yellow tint to the image.
Watercolor Makes the image appear as if it were painted using watercolors.
Wind creates an effect similar to that of a strong wind blowing the image. Wind trails 

gradually fade away.



Simple Shape Tool Options
Background Click the color square to pick a color to replace the area vacated when you 

move or delete a selection.
Mode Select “New” to create a new selection. Select “Add” if you want to retain the 

current selection as you select another area. Select “Subtract” to remove part of the current selection.
Shape Select the shape for your selection
Fixed Size Check to create selection areas of predefined sizes as defined by the entry 

boxes to the right of the check box. Clear to drag your mouse to create a selection area.
Options Menu Click to see a menu of Selection options for fine tuning your selections:

Draw from Center Check to create a selection area starting at the center and moving out.
(Only available for the Standard Selection tool.) Clear to create a selection from a corner.

Preserve Base Image Check to leave the base image unchanged when moving the 
selection. Clear to replace the space vacated when moving a selection with the background color.

Anti-aliasing Check to smooth out the edges of a moved selection or object.
Move Selection Marquee Check to move the selection shape without any image data.



Lasso Selection Tool Options
Background Click the color square to select a color to replace the selection with if you 

move or delete it.
Mode Select “New” to create a new selection. Select “Add” if you want to retain the 

current selection as you select another area. Select “Subtract” to remove part of the current selection.
Snap to Edges Check to have iPhoto Express help you trace the edge of a selection by 

finding differences in pixel color values.    
Sensitivity Set the sensitivity to determine how far from the mouse position iPhoto 

Express looks for an edge. A high setting gives iPhoto Express more freedom to create the best selection area.
Options Menu Click to see a menu of Selection options for fine tuning your selections:

Preserve Base Image Check to leave the base image unchanged when moving the 
selection. Clear to replace the space vacated when moving a selection with the background color.

Anti-aliasing Check to smooth out the edges of a moved selection or object.
Move Selection Marquee Check to move the selection shape without any image data.



Magic Wand Selection Tool Options
Background Click the color square to select a color to replace the selection with if you 

move or delete it.
Mode Select “New” to create a new selection. Select “Add” if you want to retain the 

current selection as you select another area. Select “Subtract” to remove part of the current selection.
Similarity Determine the range of colors to include in when creating the selection. For 

example, if you set the similarity to 32, and click on a pixel with a value of 128,0,128 (dark magenta), all pixels with 
values in the range of 96,0,96 to 160,32,160 will be included in the resulting selection. Note: iPhoto Express treats 
negative values as 0 or and those higher than 255 as 255.
 Select by Check Line to select similar colors to those you drag the mouse over in the 

image. Check Area to include all similar colors to those enclosed by the shape created when dragging the mouse
over the image.

Options Menu Click to see a menu of Selection options for fine tuning your selections:
Preserve Base Image Check to leave the base image unchanged when moving the 

selection. Clear to replace the space vacated when moving a selection with the background color.
Anti-aliasing Check to smooth out the edges of a moved selection or object.
Move Selection Marquee Check to move the selection shape without any image data.



Transform Tool Options
Flip Horizontal Click to transpose the left and right sides of the image.
Flip Vertical Click to transpose the top and bottom of your image.
Rotate Clockwise by Degree Enter the how much you wish to rotate the image in the Degrees entry box 

and click to spin the selection accordingly in the clockwise direction.
Rotate Counter Clockwise by Degree Enter the how much you wish to rotate the image in the Degrees 

entry box and click to spin the selection accordingly in the counter clockwise direction.
Rotate Freely Click then drag the handles on the selection to spin the image to a new angle.
Resize Click then drag the handles on the selection to make the image bigger or smaller.
Slant Click then drag the handles on the selection to move either the top and bottom or left and right edges 

of the image by the same amount in the same direction. (For example, you could make a square into a parallelogram 
this way.)

Distort Click then drag the handles on the selection to alter the angle of any edge.
Perspective Click then drag the handles on the selection to move either the top and bottom or left and right 

edges of the image by the same amount in opposite directions. (This is good for making your image appear as if it is 
going into or coming out of the page.)

.



Text Tool Options
Font Select the desired font for your text from the drop down list.
Size Select how big you want your text from the drop down list
Style Choose how to align the text, enhance your letters, (for example, bold or italicize 

them), and whether to anti-alias, (smooth) the text. 
Fill Select a color, pattern, or gradient to fill the text with.
Attribute Open a dialog box where you can change any of the above settings and 

reshape the text into a variety of unique shapes.



Lighten, Darken, and Smudge Tool Options
Shape Choose the shape and size for the brush you use to paint effects. These shapes 

are available:
    Square,      
    Circle,      
    Horizontal Line,      

    Vertical Line,      
    Left Diagonal,      
    Right Diagonal

Level Slide to the right to make the effect stronger.
Soft Edge Set a higher value to blend the edges of the changes you paint into the image 

more smoothly into the background. When setting the soft edge values, be careful not to set a size that is larger than 
the actual size of the change you paint. (Note: This is only available for the Smudge tool.)



Eraser Tool Options
Shape Choose the shape and size for the brush you use to erase with. These shapes are 

available:
    Square,      
    Circle,      
    Horizontal Line,      

    Vertical Line,      
    Left Diagonal,      
    Right Diagonal

Color Click to choose a color to replace what you erase with.



Unit
Change the unit of measure for iPhoto Express. This is most useful when the ruler is showing to provide an accurate 
idea of the actual size of the image when printed.



Ruler
Click to show a ruler at the top and left edges of the page of the image. Click again to hide the ruler.



Frame & Shadow    
Add a frame and/or shadow to the image. You can also use this command to make the outer edge of the image 
bigger. This might be useful for adding finishing touches to your images after your other editing is complete. A well 
designed frame and shadow can often be the perfect complement to an image, bringing out its highlights to 
perfection.



Print Preview Mode
    Normal
    Tile
    Poster

Print Preview mode allows you to see how your printed pages will look before you actually print them out. By 
previewing your results, you can save time and paper.

The toolbar contains these items:
Print Print the image.
Setup Choose a different printer or configure the current one.

Mode Select Normal to print a single copy of the image on each page. Select Tile to print 
several copies of the image on each page.

Copies Set how many copies to print.
Start From Assign the location of the top left corner of the image on the page.

Title Assign a title to print with the image. ("&F" tells iPhoto Express to use the file name.)

Options Shows a menu with commands for placing and sizing the image.

View Shows a menu with commands for examining the image.
Close Click to return to the iPhoto Express workspace without printing.

Note: You can also position the image on a page by dragging it to the desired location.



Title dialog box
Enter a caption to print with the image. (&f tells iPhoto Express to print the filename.)



    Print Preview Options Menu
Fit to Page Resize and reposition the image to horizontally or vertically fill the page.
Center Horizontally Center the image horizontally on the page.
Center Vertically Center the image vertically on the page.

     Print Preview View Menu
Actual View Resize the preview to the largest size that will fit the window.
Zoom In Take a closer look at the image.
Zoom Out View more of the page.
Inch Show dimensions in inches.
Cm Show dimensions in centimeters.
Ruler Show a ruler at the top and left edges of the page. (The ruler does not print out.)



Print Preview Mode
    Normal
    Tile
    Poster

Print Preview mode allows you to see how your printed pages will look before you actually print them out. By 
previewing your results, you can save time and paper.

The toolbar contains these items:
Print Print the image.
Setup Choose a different printer or configure the current one.
Mode Select Normal to print a single copy of the image on each page. Select Tile to print 

several copies of the image on each page.
Copies Set how many copies to print.
Cutting Grid Check to include dotted lines on the printed page to mark where to cut for 

equally sized images.

Options Shows a menu with commands for placing and sizing the image.
View Shows a menu with commands for examining the image.

Close Click to return to the iPhoto Express workspace without printing.



Print Preview Mode
    Normal
    Tile
    Poster

Print Preview mode allows you to see how your printed pages will look before you actually print them out. By 
previewing your results, you can save time and paper.

The toolbar contains these items:
Print Print the image.
Setup Choose a different printer or configure the current one.
Mode Reminds you that you are in Print Poster mode.
Pages Shows how many pages are required to print the poster.
Copies Set how many copies to print.
Overlap Enter how much you want you want to duplicate on connected edges. By 

including a small overlap, it may be easier for you to connect each page more easily.
Options Shows a menu with commands for placing and sizing the image.
View Shows a menu with commands for examining the image.
Close Click to return to the iPhoto Express workspace without printing.



Acquire Image dialog box
    Destination
    Post Process

Choose where to send scanned images. You are not required to open them in iPhoto Express.
New image Check to open the image in a new window.
File Check to automatically save the image as a file. Click File Name to assign a name 

and location.
Printer Check to printout the image immediately after scanning. Click Setup to configure 

the printer.
Fax / Mail Check to send the image an e-mail message. Click Setup to configure the mail 

handler accordingly. Note: this option is only available if Microsoft Exchange is installed.



About images
Images, when mentioned in the context of computer graphics, are usually considered to be bitmaps. They are 
composed up of many dots (called "pixels") arranged on a grid. If the pixels are small and close enough, you will not 
be able to see them as individual dots. Rather, they will form patterns of colors and shapes. It is this arrangement that
forms recognizable pictures for us to see.

The simplest images only contain black or white pixels. Shades and "grays" are formed by combining them in 
patterns that the human eye has trouble noticing. For example, the gray rectangle below is actually a pattern of black 
and white pixels. The inset shows the actual pattern used to create that shade.

More complex images can contain over 16 million different colors. However, these additional colors come at the cost 
of increased file size. Currently, there are six widely accepted data types used in PCs today. In order of the amount of
memory required, (least to most), they are:

Black and White    (1-bit)
Indexed 16-color    (4-bit)
Grayscale    (8-bit)
Indexed 256- color    (8-bit)
RGB HiColor    (15- or 16-bit)
RGB True Color    (24-bit)

           About color   



While the number of colors a computer can display may be tremendous, that does not mean you can tell them all 
apart. It is commonly accepted that the human eye can only distinguish between 10,000 or fewer colors at any given 
time. For further details, read About     Color  



Black and White
Black and White is a one-bit data type. That does not mean that shades of gray are impossible though. By 
combining black and white pixels in special patterns, an illusion of lighter or darker shades can be created. For 
example, the gray square below is actually a pattern of black and white. The inset shows the actual pattern:



Grayscale
Grayscale images are eight-bit data type images. They contain black, white, and 254 different shades of gray. If you 
are working on images for black and white printing, this is a good format to work with. You can easily draw and modify
images to create the shading and accents you want. When it is time to print out, you will have a very good idea about 
the appearance of the actual printout.



Indexed Color
Indexed color images have color tables, (a list of the allowable colors for the image), to define which colors can be 
used. The Indexed 16-color data type is a 4-bit data type while the 256-color data type is an 8-bit data type. Just like 
black and white images, additional colors can be simulated by combining existing colors in a pattern. For example, 
the 16-color image below creates purple by using a pattern of red and blue pixels:

Since each image can have its own unique table, the choices of available colors for two different images may be 
completely different.



RGB
RGB stands for Red, Green, and Blue, the three colors your monitor uses to create all its colors. By combining these 
colors in various proportions, all other colors can be created. There are currently two popular RGB data types; 
HiColor and True Color. HiColor is a 15- or 16-bit data type and can produce 32,268 or 65,536 different colors 
respectively. RGB True Color is a 24-bit data type and can produce over 16.7 million colors. Both of these data types 
are particularly useful if you are working with photographic quality images on your computer.



About color

 Colors are formed by light reflected off a surface. Although there are an infinite number of colors in the world, there is
a limit to how many we can see. Without considering a person's age or health, the first limitation comes from the 
visible spectrum. Only light between 380 (red) to 770 (purple) nanometers in wavelength is visible by the human eye. 
We can see any color in this range, but it is generally believed that people can only distinguish between 10 to 16-
million different colors. Further, even under the best lighting conditions, in any single moment, the range is limited to 
somewhere around 10,000. And under poor or colored lighting, this number is further reduced.    

It is important to remember this when working with digital color because there is a very real limit on the number of 
colors you can display or produce depending on the format, available memory, and your equipment. On the PC 
platform, the fewest is two, Black and White, while the most sophisticated color formats may allow over 68 billion 
colors at one time!

Depending on your needs, there are several different ways for generating colors. Each has its own strengths and 
weaknesses. The most common models are:

RGB color model — Generally used with light emitting devices like TV's and monitors
CMYK color model — Usually used for printed media like books
HSB color model — A popular format for photographers and painters
YUV / YIQ color model — A variation of the RGB Cube used for sending images over 

digital networks.
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RGB color model
The RGB model is an additive color model. By that we mean color is added to black to create the new ones. The 
more color you add, the closer to white you can get. This color model is built around the three primary colors of Red, 
Green, and Blue.

This picture of an RGB cube illustrates how the system works. The color red starts from nothing and gradually 
increases along one horizontal (x) axis. Along a second horizontal (y) axis the same thing is done for green. The 
vertical (z) axis uses blue. At the point where all three axes meet, there is no color, hence black. Diagonally through 
the cube, across from this point, Red, Green, and Blue are fully represented, creating white. If you could see the line 
connecting these two points, you would see shades of gray. As you move away from the origin along each axis, the 
value for that color increases. New colors result from combining the primary colors in proportion to the distance from 
the origin.

This color model is most popular in luminous media such as computer monitors and televisions. The reason is that 
when these devices are off, the display goes dark (black). So, adding colors to the existing black is easiest.
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CMYK color model
The CMYK color model is a subtractive color model. By that we mean that new colors come from the removal of color
from white.

Like the RGB cube, the CMYK model is based on three primary colors — Cyan, Magenta, and Yellow. If you look for 
these colors on the RGB cube, you will see they are complements (opposites) of the RGB colors. (Cyan is 
complement of Red, Magenta of Green, and Yellow of Blue.) These colors differ from the RGB primary colors in that 
they absorb instead of reflect light.

At the origin, (0,0,0), no color would be removed and white would result. Similarly, if sufficient amounts of all three 
colors were blended, all red, blue, and green would be absorbed, hence black.

So we see what C, M, and Y mean in CMYK, what about K? K represents a fourth channel added to the model for 
Black and Grays. In an ideal environment, this channel should not be necessary, but in the real world, blending cyan, 
magenta, and yellow rarely produces a rich, dark black; it usually creates a dark muddy brown. This is due to subtle 
impurities in the colors when they are blended. To overcome this problem, a pure black (and gray) channel is added 
for when those colors are needed.

The CMYK color model is used primarily in the printed media. This is because printed surfaces are reflective, (that is 
they allow us to see colors not absorbed by the surface). By using colors from the CMYK model, we can influence 
which colors are absorbed and which are reflected.
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HSB color model
The HSB cone is a completely different concept from the RGB and CMYK models. Rather than using three primary 
colors to create new ones, it treats every color of the spectrum as its own unique entity (Hue). Then black is used to 
control the brightness and white the purity (Saturation).

The colors of the spectrum are arranged in a circle around the top of the cone and identified according to their 
position relative to red. The three primary colors are arranged 120° apart with their complements directly opposite. 
Pure white is at the top center of the cone and black at the apex. If you follow a line from the outer edge to the center,
you will see color getting brighter until the bright white is achieved. Similarly, if you follow a line from the outer edge to
the apex, color darkens until only black is visible.

The best example of how the HSB model works is shown in painting. Generally speaking, artists will pick pure colors 
to work with. Then to tint the color, they add white. To shade, they add black. Finally, to create a tone, they will 
combine black and white with the pure color.
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YUV / YIQ color model
These models are variations of the RGB model. Their primary uses are for sending television signals, (YUV for PAL 
and YIQ for NTSC), but is also of interest because of its application in JPEG compression. This model interprets 
colors in terms of the luminance (Y), and two degrees of chrominance or color (U,V). The biggest downside to this 
model is that it actually changes some data during the conversion.
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Try looking at a picture of the bright blue sky under a fluorescent white light and then under a yellow light. In the 
second case, the sky will take on a green tint. Under these conditions, some colors you might otherwise easily 
distinguish may be masked by the environment.



Don't be too discouraged by the implied limitations of Black and White. By combining these two colors smartly, 
several other shades can be simulated in many types of images.



At first, you might think slides and film would use the RGB color model. Actually, CMYK is more popular. This is 
because the media upon which we are viewing is not the light that projects the images; it is the wall or film where it is 
projected.



Wallpaper
Use the current image as your Windows Wallpaper. A dialog box opens providing you advanced options for tiling, 
mirroring, and resizing your wallpaper for your screen.



Fit into Photo
 Shows a submenu containing the same options as the Replace Photo dialog box allowing 

you to resize a photo you inserted in a place holder.



Convert
Convert your images to different data types such as grayscale to color using commands from this submenu. Some 
reasons for converting include adding color to a black and whit image or optimizing images for different outputs or file 
sizes. For example, a true color image occupies a lot of unnecessary disk space if it is only intended to be printed out 
using a black and white laser printer. By converting the image to grayscale, you can save some valuable disk space.



Control Box

The Control box shows you which group is currently active and allows you to switch between groups. It also offers 
three aids for obtaining online assistance and showing or hiding the Group Strip. Click the image on the left to find out
more.



This is the currently active group.



Click this up arrow to switch to the next higher group. If the QuickTask group is the currently active group, iPhoto 
Express switches to the Finish group.



Click this down arrow to switch to the next lower group. If the Finish group is the currently active group, iPhoto 
Express switches to the QuickTask group.



Click this button to obtain instant help on a command or program feature in the iPhoto Express workspace. Your 
cursor changes to a question mark and arrow. Click on the item you want information about to open the related help 
topic.



Click this button to open the iPhoto Express Task Guide. This online document contains easy to follow, step-by-step 
instruction to lead you from start to finish for practically any project you want to complete in iPhoto Express.

Note: The iPhoto Express Task Guide is designed to remain visible at all times. If you wish to temporarily hide its 
contents without closing, simply right click on the help window and choose Keep Help on Top>Not on Top. Then press
Alt-Tab to switch between the Guide and iPhoto Express.



Click to hide or show the group strip that runs down the left side of the workspace. Hiding the strip may be useful 
when you are editing a wide image and want to be able to see more of it.



Groups
iPhoto Express divides everything you can do into five groups to help guide you through the process of completing an
image. Here is a brief description of each group.

QuickTask The QuickTask group offers short tasks for quickly starting and finishing a project with minimal effort.

Start The Start group offers tasks for adding images and photos to the workspace for editing.

Adjust The Adjust group offers tasks for fixing up images with minor problems due to poor scanning or photography.

Enhance The Enhance group offers tasks for quickly modifying your images to add special effects and other custom 
features.

Finish The Finish group offers tasks to help you distribute your finished works for others to see.



Task Bar
The Task bar shows the available tasks for the current group. It changes each time you switch groups. 



Status Bar
The Status Bar runs along the bottom of the iPhoto Express workspace. It provides useful information about you 
current iPhoto Express activity. It also buttons at the right side to enhance your editing needs:

Zoom In Increases the magnification of the current image so you can do more detailed 
work.

Zoom Out Reduces the magnification of the current image so you can see the entire 
image better.

Actual Size Shows the image at its actual size to give you a good standard reference.
Fit in Window Changes the magnification so that the entire image fits in the current 

window.
Measurement Switches the measurement units for your image between inches, centimeters, and pixels.
Ruler Show or hides a ruler around your image. Showing the ruler can be useful for providing a reference to 

how big your image will be when printed.
Photo Properties Calls the Photo Properties dialog box where you can find out important statistics about 

the current image, including file size, last time you saved it, data type, and others.



On-Line Registration
Register your copy of iPhoto Express. This command enables you to connect directly to Ulead Systems if you have a 
modem and compatible WWW Browser or E-mail program.



Currently Open Images
Lists the names of all currently open images in the workspace. Clicking on a file name activates its window



iPhoto Express Screenbook
Opens the iPhoto Express Screenbook. This online document presents a complete introduction and overview of 
iPhoto Express, showing you examples and ideas of what you can do and how you can do it. While it is intended to 
be read on line, you can also print it out to keep as a printed reference to the program.



About iPhoto Express
Displays a message box with copyright and registration information about iPhoto Express. 

www.ulead.com If you would like more information about Ulead Systems, learn some 
neat new imaging techniques, or register your iPhoto Express on-line, click here to connect to the Ulead web site at 
(You must have a compatible web browser installed on your system such as Netscape, or Microsoft Internet Explorer 
for this jump to work.)



Add Files dialog box
This dialog box is similar to the standard Windows File Open and File Save dialog boxes. Use it to select the media 
files you want to use for slide shows and screen savers. Press the Ctrl key and click individual filenames to select 
multiple, non sequential files in the current folder. Press the Shift key and click to select all files in the range from the 
previously selected filename to the one you just clicked.

Remember, you may only select image files, video files, and audio files with file formats that iPhoto Express 
recognizes for your slide shows and screen savers.
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Text Attribute dialog box
The Text Attribute dialog box allows you to change all the text settings from a central location.

Font Select the desired font for your text from the drop down list.
Size Select how big you want your text from the drop down list
Style Choose how to align the text, enhance your letters, (for example, bold or italicize 

them), and whether to anti-alias, (smooth) the text. 
Fill Select a color, pattern, or gradient to fill the text with.
Shape Choose a shape to bend or twist the text into. A sample of how your text will look 

appears in the preview window below.
Shadow Check to add a shadow to the text. When checked, the Options button is enabled

so you can adjust the size, color, and strength of the shadow.
Entry box Type the text you wish to add to the image in here. To add a carriage return, 

press the Ctrl Key as you press Enter. This is especially useful if you want to add text running down your image.
Preview Click to see how your text will look in your image without saving the settings. You

can return to the dialog box afterwards to make adjustments.



Floating Selection Properties dialog box
Allows you to review and change the characteristics of the floating selection.

Merge Determine which color characteristics of the object you want to apply to the base 
image.

Transparency Set a higher value to make the object more transparent. This allows other 
images below the object to show through more clearly.

Edge blending Set a higher value to blend the object more smoothly with the 
background. Make sure that the width does not exceed the width or height of the selection. Note: Do not perform 
Edge Blending until the object is in its final position and the base image surrounding the object is not expected to 
change.

Transparent color Check to limit the transparency of the object to a single or range of 
colors. Right click on the color square to access the color picking tools for selecting the base color.

Similarity If Transparent color is checked, set a range of similar colors to make 
transparent.

Preview Click to see how the changes will affect the actual object before applying them.



Preferences dialog box
    iPhoto Express
    Associate
    Memory
    Display
    Photo CD

Optimize how Windows manages system memory while running Ulead programs.
Temp folders Choose folders (directories) for storing temporary files while running Ulead 

programs. (Windows automatically determines the first folder.)
Hard disk Select the drive you wish to assign a temp directory to.
Limit hard disk usage to Check this and specify a value to have Ulead programs 

manage disk usage while running. This might be useful for preserving disk space for other files.
Limit RAM usage to Check this and specify a value to have Ulead programs manage 

system memory while running. This might be useful if you run several different programs at once.



Preferences dialog box
    iPhoto Express
    Associate
    Memory
    Display
    Photo CD

Control how Ulead programs display graphics.
High color dithering Check this if your display mode is High Color and you want True 

Color images to look their best on screen.
View images with a common palette Check this if you are working in 256-color mode 

and want to open grayscale and color images at the same time or when to compare 256-color images with each 
other.

Ignore background quality Check this to devote most system resources to viewing the 
active image. When selected, inactive images may appear discolored.

Monitor gamma Check this to correct your display for manufacturers' differences and the 
environment. When checked, set the gamma value so that the calibration square appears to be a single color.



Preferences dialog box
    iPhoto Express
    Associate
    Memory
    Display
    Photo CD

Choose the file formats to associate with Ulead programs. This enables you to open Ulead programs directly from 
Windows Explorer or other Windows resources by clicking on an associated file.



Preferences dialog box
    iPhoto Express
    Associate
    Memory
    Display
    Photo CD

Choose the data type and resolution for viewing PCD images.
Resolution Choose the image resolution for opening PCD files.
Data type Choose the data type for opening or viewing PCD files.



Photo CD images can be displayed at the following resolutions (pixels):
64 x 96
128 x 192
256 x 384
512 x 768
1024 x 1536
2048 x 3072
4096 x 6144



Photo CD images can be displayed using the following data types:
True Color
Indexed 256-Color
Grayscale



Make sure each of your temporary directories is on a different drive or partition.



This does not affect the actual data, it just affects appearance when not active.



Texture Library dialog box
Click on the texture you want to place in the image.

Options Click to access the Magic Texture dialog box where you can create your own 
magic textures.



Magic Texture dialog box
Select a texture to add to the image.

Sample tiles The center tile shows the currently selected texture. Click a bordering tile to 
shift the texture accordingly. You may repeat this action several times until you find the texture you want.

Random Change the center tile to a randomly selected other texture.



Select Base Image
Deselect but still retain the floating selection. This is a good way to preview how you image is turning out without 
requiring you to go through undos and redos



Duplicate
Copies the floating selection and places the copy into the same image.



Select Previous Selection
Deselects the current floating selection and re-selects the previous selection.



Delete
Removes the floating selection from the image without affecting the base image below.



Add / Remove Shadow
Add Shadow Adds a shadow to the selection. This gives your image a more three 

dimensional appearance
Remove Shadow Removes a shadow you added to a floating selection. You can only 

remove a shadow if the selection is still floating.



If space is a problem, choose a compressed file format to save your images with. For True Color images, the JPEG 
(JPG) format can reduce your file size to a fraction of its uncompressed size.



Joining two images
1. Make sure both images you want to join are open and either grayscale or RGB true color images.
2. Select one of the images to join, (it doesn't matter which), and from the Edit menu, choose "Stitch."
3. Select the other image for stitching.
4. Drag the images in the dialog box so that they are in the right order.
5. Select the Manually option and check "Auto fine tune."
6. Press the Shift key and click on a reference point in the original image.
7. Press the Shift key and click on a point in the other image that you want to be close to the point you clicked in step

6.
8. Click OK.



Straightening images
If your scanned image is slightly crooked, simply click Straighten from the Adjust group and iPhoto Express will 
automatically fix it. If the automatic fix is not good enough, then from the Edit menu, choose Rotate & Flip. Then 
choose Rotate Freely.
Straightening images when stitching
1. Double-click the image to rotate.
2. Click Rotate Horizontal  or Rotate Vertical 

.
3. Drag the control points on the line that appears in the image so that the line identifies a section you want to 
be horizontal or vertical.
4. Double-click on either control point to accept the setting.

Note: This is a particularly useful way to straighten an image that was improperly aligned when scanned.



Trimming unwanted edges
If you have an unwanted border around your image, or if you only want a small portion of an image for your current 
work, you can trim away all unwanted parts and automatically resize the image with the Crop task. Here’s how:
1. Click Enhance and then use any of the Select tasks to create a selection of the part of the image you want to keep.

(You can make this selection any shape or size.)
2. Click the Crop task. iPhoto Express deletes all parts of the image that were not selected, creating the smallest 

rectangular image that will retain the parts you wanted to keep. If your original selection was not rectangular, 
iPhoto Express automatically fills areas that do not contain original image data with the background color.

Note: You can also crop without first creating a selection area. From the Edit Menu, choose Crop. Then drag the 
handles that appear on your image to surround the part you want to keep and double-click.



Placing images into iPhoto Express
There are lots of ways to put an image into iPhoto Express for you to enhance. Here are a few of the more popular 
ways. You may find others on your own:

Start Section The Start Section contains five tasks that let you insert any kind of image 
into iPhoto Express:

Open opens the Open dialog box where you can select images from your system to place 
in the iPhoto Express workspace. Press and hold the Ctrl key to select more than one image in the same folder to 
open at one time. Press the Shift key to select a range of images. Remember, as you increase the number of images 
you have open at one time, you will slow down your computer, so don’t open too many!

 Scan opens the Acquire dialog box where you can set up your connected TWAIN 
compatible scanner to copy your favorite photographs or other images into the iPhoto Express workspace.

Import allows you to use some other equipment, such as a digital camera as the starting 
point for creating an image in iPhoto Express.

 New opens the New dialog box where you can specify the size and type of image you 
want to create from scratch. When you close the New dialog box, an empty image appears in the center of the iPhoto
Express workspace. 

Paste Document places image data on the clipboard into iPhoto Express. This can be 
useful if you wish to copy or edit artwork from another program, such as your word processor.

Menu Commands Many of the above tasks are available in the File menu. That way, if 
you wish to add an image to the iPhoto Express workspace while you are in the middle of another one, you don’t 
need to switch groups.

Drag and Drop If the program that contains the image you wish to edit supports Drag and
Drop, you can always select and drag the image from that program to iPhoto Express. Some programs that support 
Drag and Drop include iPhoto Express Explorer, Windows Explorer, and all Microsoft Office compatible programs.



Saving your work
Whether you are finished with your image, or just want to take a short break, it is always a good idea to save your 
work periodically. Not only does this make it easier for you to retrieve information, but it also protects you against 
losing your work due to unforeseen accidents. When you save, you can

Create a new file From the File menu, choose "Save As" and assign the image a name 
and location.

Overwrite the original file If you saved your image earlier, you can replace the old file 
with the current changes. From the File menu, choose "Save."



Presenting your work
The Finish group contains several tasks to help you present your finished images to your friends and colleagues. 
Many of these tasks are simple one or two step processes:
Simple printing
1. Click Print and choose “Print” to switch to Print preview mode. 
2. Enter the caption to include with the image in the Title box, ("&f" tells iPhoto Express to use the file name as the 

caption). 
3. Set other settings if necessary and then click Print.    

Printing large images
1. Click Print and choose “Print Poster” to switch to Print Preview Mode.
2. Click the Options button and Choose Layout to open the Layout dialog box. This allows you to resize the image 

and set page margins for the poster tiles.
3. Click OK to close the Layout dialog box and then set the overlap options to determine how much image 

information should be duplicated on adjacent sheets. By overlapping a little of your image, you can assemble each
sheet more easily.

4. If necessary, set other printing options according to your needs and click Print.        

Printing multiple copies of a small image on a single page
1. Click Print and choose “Print Tile” to switch to Print Preview Mode.
2. Click the Options button and Choose Customize to change the number of images to print on a single page and 

determine the distance separating each one.
3. Click OK to close the Layout dialog box and then check “Cutting grid” to include dotted lines that show where to 

cut to separate each image.
4. If necessary, set other printing options according to your needs and click Print.

Sending E-mail

Click Send to open the Send dialog box. Here you can enter a message to accompany the image.

Creating a calendar

Click Calendar to open the Calendar dialog box. Here you can include the image as the masthead for printing a 
monthly calendar.

Screen Art

Click Screen Art to see a submenu of choices for showing your work on line. The Screen Art task offers you the ability
to create Windows wallpaper, slide shows, and screen savers from your images. 



Customizing how iPhoto Express works
By customizing iPhoto Express to your needs, you can make sure the program looks and behaves best for your own 
working style. You can set how many undos and redos iPhoto Express permits, how your screen and images appear, 
and how your computer uses memory while iPhoto Express is running. Here’s how:
1. From the File menu, choose "Preferences."
2. Click the iPhoto Express tab.
3. Choose the settings you want for determining iPhoto Express behavior.
4. Click OK.

Showing and hiding the ruler

Click the ruler button (        ) to show a ruler around your image. This gives you a better idea of the size when 
printed. Click again to hide the ruler.
Setting the ruler measurements
Click the measurement button (        ) to choose what measurements to show in the ruler. You 
may choose between inches, cm, and pixels.



Adding a border to your image
Adding a border to you image helps give your images dimension or make them stand out.
1. Switch to the Enhance group and click "Frame & Shadow." 
2. In the Frame dialog box, choose a color for the shadow and border by clicking their associated color squares.
3. Set the width for each item by dragging the appropriate slider or entering a value in the related text box.
4. If using a shadow, select its direction.
5 Click OK.

Note: If a color chosen for Indexed-Color or Grayscale images is not in the current palette, iPhoto Express 
automatically replaces it with the closest matching color or gray value available.



Resizing images
Before you change the size of your image, think about why you are doing so. Is it to make the image print bigger or 
smaller? Is it because the file size is too big?

Without changing data or file size

If you only care about how big the image is when printed, change the resolution to resize the image. These changes 
will not appear on your screen, but will be immediately apparent when you print.
1. In the Adjust group, click Resize. 
2. In the Resize dialog box, click the Resolution tab. Increase the resolution to make the image smaller. Reduce the 

resolution to make it bigger.

Changing the physical size of your image

Changing the dimensions of your image creates or deletes data. If you make the image bigger, iPhoto Express adds 
new colors to your image to make the image retain its same general appearance. If you make the image smaller, 
iPhoto Express deletes or alters image data to retain the same appearance at the smaller size.
1. In the Adjust group, click Resize. 
2. In the Resize dialog box, click the Dimension tab. 
3. Set a new size for your image and click OK.

Note: You can also use your mouse to resize selected areas using the Transform task in the Enhance group.



Converting images
You may wish to convert images so that they will look the same in different display modes. Other reasons for 
converting could include wanting to use a unique file format that is only supported by certain data types or wanting to 
add details that the current data type does not allow. (For example, you must be in true-color or grayscale to use the 
Effect Palette.)
1. From the Photo menu, choose "Convert."
2. Choose the desired data type from the resulting submenu.



Managing your computer’s memory
Your computer’s efficiency depends heavily on how much memory it has available. iPhoto Express allows you to tell 
the computer where to concentrate so that the most amount of memory is available while you work. This allows your 
computer to work faster and more smoothly.
1. From the File menu, choose "Preferences."
2. Click the Memory tab.
3. Enter folder names for storing temporary information. (Do not specify two temporary folders in the same drive or 

partition.)
4. Check Limit hard disk usage to:, and set a value to have Ulead programs limit disk space used while running. 

Leave it unchecked to use Windows defaults.
5. Check Limit RAM usage to: and set a value to have Ulead programs limit RAM used while running. Leave it 

unchecked to use Windows defaults.
6. Click OK.



Calibrating the display
Each display appears a little different from others. And your images, when printed may look different too. By 
calibrating your display, you can minimize these kinds of variations by correcting your colors to a common standard.
1. From the File menu, choose "Preferences."
2. Click the Display tab.
3. Check Monitor gamma.
4. Raise or lower the gamma value until the gray box looks something like this:

Note: Increase your distance from the monitor to about six feet, (2 m), to make the pattern in the upper rectangle less
apparent.
5.  Click OK.



Quitting iPhoto Express
From the File menu, choose "Exit."
Click the Exit button on the top right corner of the iPhoto Express Title Bar.
Double-click the top left corner of the iPhoto Express Title Bar.

iPhoto Express prompts you to save any images that were changed since you last saved them.

           Saving images   



Reshaping images
All the tools for resizing, reshaping and rotating images are on the Transform task in the Enhance group. To use 
these tools:
1. Select or create an object for reshaping.
2. Switch to the Enhance group and click the Transform task.
3. Choose the desired Reshaping tool from the option bar. These tools are available:

Resize Enlarges or shrinks the object.
Slant Moves the left and right or top and bottom edges equally.
Distort Moves a single control point independently of any others.
Perspective Moves two adjacent control points equally towards or away from each other.



Instant rotating and flipping
1. Select the image you wish to flip or rotate and from the Edit menu, choose "Rotate & Flip." A submenu with these 

choices shows:
Flip Horizontally
Flip Vertically
Rotate 90º Right
Rotate 90º Left
Rotate 180º
Free Rotate

2. Choose the desired command.

Notes:
If nothing is selected, iPhoto Express rotates or flips the entire image.
Some combinations of these commands are also available from the Rotate/Flip task in the Adjust group and the 
Transform task in the Enhance group.



Rotating with the mouse
If you want fine control of how you spin your image, here’s how:
1. Select the image or object to rotate.
2. Select the Transform task.
3. Select the Free Rotate tool.
4. Drag the control points to the desired rotation.



Rotating by degree
For total control of your image rotation right down to the degree, try this method of rotating:
1. Select the image or object to rotate. If nothing is selected, iPhoto Express rotates the entire image, resizing it if 

necessary.
2. Select the Transform task.
3. Enter the desired rotation in degrees and select the Rotate Clockwise  or Rotate Counterclockwise 

 button. 



Creating selection areas
iPhoto Express Makes isolating parts of your image easy by providing three different ways to select what you want. 
Once you make a selection, you can move, delete, edit, or enhance it. All the selection tasks are in the Enhance 
group.
Rectangular and elliptical selections
1. Click Select and choose Simple Shape.
2. In the attribute toolbar, select the desired shape for the selection from the Shape drop-down list.
3. Drag the mouse over the area you want to select.

Freehand selections
1. Click Select and choose Lasso.
2. Drag the mouse around the edge of the area you wish to select

      - and / or -
click and release the mouse button at different points for a series of connected straight line segments.

3. Double-click to complete the selection.
Selecting by color
1. Click Select and choose Magic Wand.
2. Set the color similarity to determine the range of colors to select relative to the reference color.
3. Click on or drag over the base image to select reference colors and a starting area.

Note: To add to an existing selection, press "A" as you select. To remove part of a selection, press "S" as you define 
the selection to remove. (You may also select Add or Subtract from the Mode drop-down list.)



Moving a selection
1. Switch to the Enhance group and use any of the selection tools to select or create a selection. 
2. Click anywhere inside the selection and drag it to a new location.

Drag the selection to an empty spot in the workspace to create a new image.
To move the selection border without moving any image data, click options ( 

 ) and check "Move Selection Marquee." 



Blending selections into images
Depending on the tool or task you are using, these features enable you to smoothly blend an object into the base 
image:

Anti-alias Smoothes curves so they do not appear jagged due to pixelization. (This is best
when working with text.)

Soft Edge Fades the edges of a floating selection gradually so that it blends into the 
background more smoothly.

Smudge Tool Smears the image making borders less clear.



Adding shadows to selections
Adding shadows to selections gives them more depth and helps them fit into your image better.
1. Right click on the selection and choose "Add Shadow ".
2. Choose a color and direction for the shadow.
3. Increase the x offset to make the shadow larger horizontally. Reduce it to make the shadow smaller.
4. Increase the y offset to make the shadow larger vertically. Reduce it to make the shadow smaller.
5. Click Preview to check the results.
6. Click OK.



Recovering from mistakes
Undoing

From the Edit menu, choose "Undo Before" and select the last step you want to recover. (The number of undo steps 
you can perform depends on the iPhoto Express preferences settings.) 
Redoing
From the Edit menu, choose "Redo To" to reapply commands you undid with "Undo Before." 



Merging a floating selection to the image
1. Switch to the Enhance group and use any of the selection tools to select the floating selection. 
2. Right click on the object and choose "Merge."

Note: Once you merge a selection it cannot be reselected easily. It becomes even harder to reselect if any edge 
blending or transparency features were used prior to merging.



Applying filters and effects
With iPhoto Express adding special effects and filters to your images is simply a matter of seeing what you like in the 
Effect Palette. You can apply the effects and filters as is or modify them slightly to your own unique needs.

As-is

This is the fastest way to apply a filter and effect. Just switch to the Enhance group and click Effects to show the 
Effect Palette. Then

drag the desired effect from the Effect Palette to the image.
      or

double-click on the desired effect in the Effect Palette.

Custom Setting
1. Switch to the Enhance group and click Effect palette to show the Effect Palette.
2. Click the effect or filter you wish to apply.
3. Click Options (  ) and choose Modify Properties and Apply.
4. In the resulting dialog box, adjust the effect or filter settings so that the preview image appears the way you 
want.
5. Click Preview.
6. Click OK to accept the settings, Continue to return to the dialog box and adjust them some more, Undo and 
Redo to toggle before and after views, or Cancel to return to editing without applying the filter. 



Arranging the workspace and desktop
iPhoto Express offers you two ways to rearrange your screen so that your work is easier.

Effect Palette

You can arrange the iPhoto Express workspace so that half of it is occupied by the Effect Palette and the other half by
the active image.
1. Switch to the Enhance group and click Effect palette to show the Effect Palette.
2. Click Options (  ) and choose Tile Effect Palette. From the resulting submenu, choose the 

arrangement you want for the workspace.

iPhoto Express Explorer

By placing iPhoto Express Explorer along the right side of your screen, you never need to call any commands or 
dialog boxes to find images or templates to load into iPhoto Express. Just drag them from iPhoto Express Explorer 
into the iPhoto Express workspace. To arrange your desktop with iPhoto Express Explorer, from the Window menu, 
Choose "Tile with iPhoto Express Explorer".



Deleting data
Sometimes, rather than adding to an image, you want to remove. Here are some ways to do it:

Delete key

Pressing delete on a selection removes data from the base image, filling it with the current background color.

Delete command

Right click on a selection and choose "Delete."

Erasing

Switch to the Enhance group. Then, from the Paint task, select the eraser to delete data from the image and replace 
it with the background color.

Cloning

The previously mentioned methods use a single color to replace removed image data. But what if you want to keep 
the background? Well you can do that too. Here’s how:
1. Select the Image Clone tool. 
2. Press the Shift key and click on the image or where you want to clone from.
3. Click and drag the mouse where you want to clone the image to.

Note: You may clone from one open image to another.



Color fills
Use Fills to create vivid backdrops for your images.

Flat fills
1. Switch to the Enhance group. Then, from the Paint task, choose Bucket Fill.
2. Right click on the color square to select the fill color.
3. Set the Similarity to determine how iPhoto Express determines what region to fill.
4. Set the transparency to determine how well the underlying image shows through the fill.
5. Click on the selection you want to fill.

Gradient Fills
1. Switch to the Enhance group. Then, from the Paint task, choose Gradient Fill.
2. Right click on the beginning and ending color squares to select the fill colors.
3. Set the transparency to determine how well the underlying image shows through the fill.
4. Click on the selection where you want to start the fill and drag to where you want the ending color to be reached. 

Eligible areas beyond these points will be filled with the start or end colors.

Note: You can also add gradient and texture fills to text by clicking the color square in the Text attribute toolbar.



Pattern fills
1. Select the area you want to fill. If nothing is selected the entire image will be filled.
2. From the Edit menu, choose "Fill."
3. Select the pattern or color you want for the fill and click OK.
      Or

If there is image data on the clipboard that you wish to tile as a fill, select Clipboard and click OK.

Note: For gradient fills, use the Gradient Fill in the Paint task of the Enhance group.



Adding plug-ins
iPhoto Express allows you to add to its versatility by using Adobe PhotoShop Compatible plug-ins with it. Depending 
on the type of plug-in, new commands will appear either in the Import or Export submenus in the File Menu or at the 
end of the Photo Menu. To add third party plug-ins to iPhoto Express:
1. Install the plug-ins according to their documentation. Make sure you note the name and path for the folder where 

you install them.
2. Make a backup copy of your ULEAD32.INI, (located in your default Windows folder).
3. Open the original ULEAD32.INI file and create a PLUG IN section in it if it does not already exist by adding the 

following:
[PLUG IN]

4. For each folder containing plug-ins add a line as follows:
PLUGINDIRn = drive:\foldername

where n changes sequentially, starting with 1 for the first folder.
           Example   



Dragging and Dropping
Use Drag and drop to enhance the speed and ease of editing:

From one place to another Drag selections from an image to the iPhoto Express 
workspace or another image. To keep the selection in its original image also, press the Ctrl Key as you drag.

Tile Fill Press T as you drag and drop to an image.
Effect Palette Drag an effect from the Effect Palette to an image to apply it to the image.



Adding text 
1. Switch to the Enhance group and click the Text task.
2. Click where you want to add the text. The Text Attribute dialog box opens.
3. Enter the desired text in the Text Entry box. To add multiple lines at one time, press the Ctrl key as you press 

Enter. This is especially useful if you want to add text running down the image.
4. Select a font, size and style for your text.
5. Click the color square to access the Ulead Color Picker to change the text color. 
6. Choose a shape from the Shape drop down list to bend or curl the text.
7. Click OK.



Working with the Effect Palette
Click the Options button ( 

 ) and choose Tile Effect Palette to automatically rearrange the workspace so that the current 
image and Effect Palette fill the workspace

In the Enhance group, click Effect Palette button to show the Effect Palette. Press again to
hide it.

Drag thumbnails from the Effect Palette to an image to immediately apply that effect.
Click the Options button ( 

 ) and choose “Modify Properties and Apply” to custom set a filter or effect before applying it to 
your image.



Painting
1. In the Enhance group, click Paint and select a Paint tool.
2. Set the brush shape, size, and other characteristics from the attribute toolbar.
3. Click the color square to change its current color.
4. Drag the mouse over the image where you want to paint.



Touching up an image
As you complete your images, you may find small areas that need subtle adjustments. This is where the touchup 
tools, in the Paint task of the Enhance group, come in handy. They allow you to highlight or downplay parts of your 
image using your mouse as a touch up brush.
1. Switch to the Enhance group and click Paint.
2. Choose a Retouch tool.  

 

2. Set the brush shape, size, and other characteristics from the attribute toolbar.
3. Drag the mouse over the image where you want to touch it up.



Any black pixels in the selection are opaque. White pixels are clear. Grays are partially transparent according to how 
close to white or black their values are.



In the RGB color model, a neutral color is one that has the same R, G, and B values. Look below the preview window
for the current RGB values in the image and click when the mouse is over a color (pixel) you want to be perfectly 
neutral.



The manual tab shifts the colors in the image according to the HSB cone. The thumbnail immediately to the right of 
the reference thumbnail shifts the image towards red. Going clockwise, the other key colors are magenta (lower right 
corner), blue (lower left corner), cyan (across from red), green (top left corner), and yellow (top right corner). By 
progressively clicking on the squares, you can shift the colors to the desired hue.



For example, if you installed Kai's Power Tools in your system at C:\KPT, here is what you would add to the end of 
your ULEAD32.INI

[PLUG IN]
PLUGINDIR1 = C:\KPT



Wind dialog box
Create a feeling of a wind blown image. 

Direction Choose the direction the wind blows.
Moving offset Set a high value to create a stronger wind effect.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview 

window.



Sharpen dialog box
Makes edges stand out more distinctly in an image.

Level Choose higher to get stronger borders.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview 

window.



Mosaic dialog box
Blurs the image into blocks by averaging pixel values in each block.

X-axis size Set the width of each square in pixels.
Y-axis size Set the height for each square in pixels.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview 

window.
Square Check Square to make each block a perfect square.

Note: If the block size does evenly fit into the image, the blocks are cropped starting from the lower right corner.



Ripple dialog box
Adds waves to an image as if viewed through water.

Direction Choose Center to create waves start from the center and move out in a circular 
pattern. Choose Edge for waves that appear to be flowing across the image.

Frequency Choose a high value for more waves.
Amplitude Choose a high value for larger waves.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview 

window.



Watercolor dialog box
Enriches the colors in an image to simulate the appearance of a watercolor painting.

Stroke size Choose Small for short brush strokes. Choose Large for big strokes.
Moisture level Set higher levels to add streaking typical of paints with higher water 

content.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview 

window.



Hue & Saturation dialog box
Controls the balance and intensity of color in an image.

Hue Shift the hue value of each pixel in an image by the amount specified. For example, a
yellow pixel will become blue if you set the hue to 180.

Saturation add or remove color to an image. Fully reducing saturation results in a 
grayscale image; fully increasing makes the color very rich.

Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview 

window.



Emboss dialog box
Displays an image as a single-color imprint on a solid surface.

Light source Choose the direction of shadows on the image and which parts should 
appear raised or indented. Light sources from above cause dark areas to look raised. From below, dark areas look 
indented.

Coating color Click to select a new color for the image.
Depth Set how strong the embossed effect is. Higher settings cause a more pronounced 

embossed effect.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview 

window.



Tile dialog box
Breaks an image into square tiles and shifts them as if they are being placed or removed from the image.

Background color Click to select a new color for the borders of the squares.
Square size Set the size in pixels of each tile. If the size does not evenly fit in the image, 

squares are cropped from the lower right.
Shift value Set a higher value to randomize the order of the tiles more. A value of zero 

creates a well organized tiled effect.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview 

window.



Warm / Cool dialog box
Add tint to an image producing a warmer or cooler feeling.

Color Choose the tint you wish to apply.
Level Set a higher value to apply a stronger tint. As the level increases the tint becomes 

more dominant.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview 

window.



Fat / Thin dialog box
Fat expands an image at the center. Thin squeezes compresses an image at the center.

Level Set a higher level to expand (Fat) or compress(Thin) the image more.
Preview Click to see how the changes will affect the actual image before applying them.
Thumbnail Choose a portion of the active image to show in the dialog box preview 

window.



Thumbnail dialog box
Allows you to choose what appears in the dialog box preview window while applying the filter. This can be useful if 
you are concerned about a particular region, or to change the magnification in the preview window. 

Whole image Scale the entire image to fit in the preview window.

1x Select a portion of the image to show at full size in the preview window.

Custom size Select any part of the image to show in the preview window. iPhoto Express automatically resizes areas
larger than the preview window. 



Turnpage dialog box
Curls up a corner of an image like you're turning a page.

Sample source & control points Displays the currently selected image, the slant angle controls, and the page 
turning rate control. Click on the left for more information.

Type Select the shape of the curl to apply.
Mode Select the appearance of the curled portion.
Background color Displays the current background color. Click to change the 

background color.
Corner Select which corner to curl up.
Angle Click on the red dot (or the + / - ) to define the page curl size. (A smaller angle 

produces a bigger curl size.)
Lighting direction Click and drag the lighting direction control point to define the shadow 

effect of the curled portion.
Preview Click to see how the changes will affect the actual image before applying them.



Slant angle control point  Click and drag the control points to limit the portion to curl. The valid value ranges from 
45 to 80 degrees.



Page turning rate control point Slide along the diagonal formed by the slant angle control points. The valid value 
ranges from 0 to 100. Zero produces a no turned page effect and 100 makes the entire image disappear.



Allows you to select the shape for the curl.

Results in a cylinder shaped turn page.
Results in a cone shaped turn page.



Allows you to select the corner to curl up from the four corners of a page.
Curls up the top left corner.
Curls up the top right corner.
Curls up the bottom left corner.
Curls up the bottom right corner.



Allows you to select the appearance of the curled portion.

Opaque Shows a non-transparent nor translucent curl.

Reverse Shows a reflection of the image in the curl.

Transparent Shows the image through the curl.



Remove Red Eyes dialog box
Sometimes when you take flash photographs, people in the pictures appear with red eyes instead of their natural 
colors. This dialog box helps you fix photos with this problem.

Preview images The image on the left shows an uncorrected view of the image you wish 
to adjust. One or two rectangular outlines, (depending on the Eye Size selection), identify the areas to correct. The 
right image shows the how the corrected image will appear.

Zoom in Increase the magnification of the preview images so that you can more clearly 
identify the areas to correct.

Zoom out Reduce the magnification of the preview images so you can see more of the 
image.

Reset Return the magnification of the preview images to the original size so that they fit the preview 
windows.

Select area of eyes Choose whether to correct one or two areas and how large an area 
to correct.

Red tolerance Slide to the right to increase how sensitive the filter is to red.
Effect level Slide to the right to increase how strongly the desired color for replacing the 

red should appear.
Color Click the color square to choose a color to replace the red with.
Preview See how the changes will affect the actual image before applying them.



Calendar
The Calendar Dialog box contains all the controls you need to create fantastic monthly calendars out of your favorite 
photographs. With several preset templates to help you get started, each calendar you create will take only a few 
minutes to complete and print out.

Preview Click and drag various elements in the Preview window to position them the way 
you want on the page. Drag the handles at the edges to resize images and text as necessary. Right-clicking on 
different elements brings up a submenu with commands for adding further control to how that element appears.

Template Click    
    to create a long (portrait-style) or    

    for a wide (landscape-style) page. Then choose a template from the scrolling list of 
thumbnails for a starting point for your calendar.

Year, month Choose a year and month for your calendar. iPhoto Express automatically 
determines the correct days of the week for the month you choose.

Print Click to send the finished calendar to the printer.
Print Setup Click to open the Print Setup dialog box for changing your printer settings.
Wallpaper Click to use the calendar you created as your Windows wallpaper. The iPhoto 

Express Wallpaper dialog box opens.
To Clipboard Click to copy the calendar as an image to the clipboard. You can then paste

the calendar into another program.
Font and Color Click to open the Font and Color dialog box. Here you can choose the 

colors and styles for text elements in your calendar. The dialog box allows you to choose the text by appearance 
instead of requiring you to remember ambiguous and confusing font names.

Close Click to close the Calendar dialog box. 



Video Capture dialog box
The Video Capture dialog box allows you to open images in the iPhoto Express workspace that you obtained from a 
video tape. You can capture a single frame or several frames during one occurrence of this dialog box.

Preview window Shows the video as it plays back from your attached video playback 
device. Right click on the preview window to freeze a frame. Right click again to unfreeze. (Note: your video playback
device continues playing even if the preview window frame is frozen.)

Get Image Click to capture the current frame to iPhoto Express. Each time you click Get 
Image a new image gets captured.

Exit Close the Video Capture dialog box and return to iPhoto Express.
Video format Depending on the capture card, allows you to change the display mode of 

your capture card. The dialog box may change sizes if you change the Video Display mode for your capture card, but 
it will not affect any of your other windows display settings.

Video display Depending on the capture card, allows you to adjust the colors for your 
video playback. Some things you might be able to control are hue, saturation, brightness, and contrast.

Video source Depending on the video card and if you have multiple devices connected to
it, allows you to choose which source to use for the video playback.

Video mode If your card supports Overlay video, select Overlay to use fewer system 
resources to play the video and see a smoother playback.



Technical support
Please prepare the following information before contacting us so we can offer you the best possible support:

The program name and serial number.
Nature of the problem.
Any error messages or dialog boxes that appear when the problem occurs.
System information including CPU, operating system, and any other programs running 

when the problem occurs.

If you write or fax us, please add printouts of the following:
AUTOEXEC.BAT
CONFIG.SYS
WIN.INI
ULEAD32.INI

Note: You can open most of these files at once by running SYSEDIT.EXE, found in your Windows program directory.

           How to contact us   



How to contact us
Click below for more information on contacting us.
North and South

 America International

. Phone .

. Fax .

. Mail .

. BBS .

. .

    E-Mail    

    .

For the latest information about Ulead Systems and new product information, point your web browser to

    www.ulead.com    



Call 

+886-2-764-8599 



Send a fax to
+886-2-764-9599



Send a letter to

Ulead Systems, Inc.
10F, 111 Tung Hsing Road
Taipei, Taiwan, R.O.C.



Dial up the Ulead BBS at

+886-2-764-7585 19200 bps (N,8,1)



Call

(310)-523-9391 



Send a fax to 

(310)-523-9399



Send a letter to

Ulead Systems, Inc.
970 West 190th Street, Suite 520
Torrance, CA 90502



Dial up the Ulead BBS at

(310)-523-9389 19200 bps (N,8,1)



Send E-Mail to

support@ulead.com.tw



Send E-Mail to

support@ulead.com



File formats supported by iPhoto Express
iPhoto Express supports many different file formats for editing or displaying. Here is a list of all the formats you can 
use with iPhoto Express. Here is a key to help you better understand what you can and cannot do in with these 
formats in iPhoto Express.

These are image file formats that you can open and save in iPhoto Express

These are file formats that you can only view in iPhoto Express. If the format is an image format, you can open it in 
iPhoto Express, but you must save it as a different format.

Adobe PhotoShop (PSD) This format was created by Adobe Systems Inc. for use with their high-end image 
enhancement program. It supports all data types and is one the most popular formats for professional photographers 
who use desktop computers to touch up their work.

Generic Fax (G3 1-D Encoded) (FAX) A black and white file format used by generic digital fax software. This format 
uses CCITT compression to minimize file size.

JPEG File Interchange Format (JPG) The JPEG format is best suited for digital photographs and other natural-
looking images. It is not as good for precise artwork such as line-art. This is because some "averaging" takes place 
during compression, and edges may be blurred. In photographs, this is not so noticeable because such sharp edges 
are rare. It uses a lossy compression method to achieve compression ratios of up to 100 to 1 which is much better 
than most other compression methods. This format supports grayscale and True Color data types; because it uses a 
lossy compression method, indexed and black and white data types do not reproduce well and are not supported. 
One interesting feature of this format is that you can vary the degree of compression. So you can decide what level of
data retention vs. space savings is best for your needs.

Kodak Photo CD (PCD) When the prospect of using computers to save images became a reality, Eastman Kodak 
developed this format to store photographs digitally. This proprietary format is used by images in Kodak CDs. To 
support multiple display modes, each PCD file contains image data in 5 resolutions, and allows you to choose 
between viewing the image in True Color, indexed 256 color, or grayscale.

Microsoft Windows Cursor (CUR) Your mouse pointer likely uses (or at one time used) the .CUR format. The 
features that set this format apart from most other file formats are that it can only be 32 x 32 pixels in size and it is a 
2-bit data type, using Black, white, transparent, and inverse. When Ulead programs open .CUR files, the transparent 
color appears as white and the inverse color as black.

PC Paintbrush (PCX) Originally developed by ZSoft Corporation for their PC Paintbrush program, this format gained 
early popularity. Shortly after its development, ZSoft entered into several OEM agreements with early fax board and 
scanner manufactures. As a result, this format has become an important standard on the PC and other desktop 
platforms. It supports all data types. 

Portable Network Graphics (PNG) PNG, pronounced "Ping," was developed to replace the GIF due to proprietary 
concerns. It is designed primarily for sharing image data on line. Perhaps one of the most fascinating aspects of this 
format is how it opens images. Unlike most other file formats, this one is designed to show a representation of the 
image as fast as possible. When opening a PNG image, it first appears out of focus and gradually becomes more 
clear. In this way, you gain a better idea of the entire image faster, (and can cancel a download sooner if you see that 
you don't want it). Another feature, especially designed for on-line concerns, is easy file checking for transmission 
accuracy and against file corruption. PNG supports indexed 256 color, true color, and grayscale data types.

Run Length Encoded (RLE) This device independent format is especially well suited for simple images containing 
long strings of repeated information stored in Pack Bit form. Many paint programs, including MacPaint, support this 
format. Ulead programs support indexed 16- and 256-collor RLE files.



Tagged Image File Format (TIF) This is a standard file format for most imaging programs which supports all data 
types from monochrome up to 24-bit true color, as well as many color models and compression schemes. An even 
more powerful aspect of TIF is that its files can move easily between platforms, making it an ideal format for storing 
image data.

Targa (TGA) This format, one of the principal true color image formats, can store image data with up to 32 bits per 
pixel. Compared to TIF and JPEG which are other options for true color images, TGA is relatively simple and 
therefore widely used in imaging programs. The only drawback to this format is that it lacks a good compression 
scheme.

Ulead Template (TPL) This proprietary file format was designed by Ulead Systems for iPhoto Express templates. It is
the only format supported by Ulead programs that allows objects you to save place holders for images you want to 
modify several times. TPL files use RLE or no compression when saved.

 Windows Bitmap (BMP) This is a widely recognized format made popular by Microsoft Windows and IBM OS/2. It 
supports several data types ranging from black and white all the way up to 24-bit True Color. It is good for images you
want for your Windows wallpaper or to distribute to others who you know have Windows, but are not sure of what 
else. Although the BMP format supports RLE compression, most programs (including Ulead) do not take advantage 
of it.



Layout dialog box
The Layout dialog box allows you to specify the placement and size of the printed area on images you decide to print 
out

Image size Enter the desired size as a measurement or proportion of the actual image 
size. If you enter a physical size, the proportion automatically updates. If you enter a proportion, the printed size 
automatically changes.

Keep aspect ratio Check to retain the width and height relationship for the image when 
you change its dimensions. When checked, if you change one size setting, the others all automatically update.

Fit to page Resizes the image to use the entire printable area of the page. 
Print information Set the top and left margins for defining where printing begins on each 

page. The Width and Height items show what size paper the current printer is set to print with.



Select Pages dialog box
The Select Pages dialog box shows you how the images intended to print spanning multiple pages will be arranged. It
also allows you to select specific pages for printing if you only want a part of the poster.

Page number The shaded area shows where the printed area for each page. Shows the 
arrangement of the pages. The darkened shades identify the pages selected for printing. The lighter shades are 
pages that will not be printed.

All pages Select all the pages for printing. All pages in the Selected Pages section 
become dark.

Selected page(s) Enter the page numbers for the pages you wish to print, separating 
each page number by a space. As you enter a page number, its page in the Selected Pages section becomes dark.



Tile with iPhoto Express Explorer
Rearrange your desktop to tile iPhoto Express Explorer in Compact Mode to the right of iPhoto Express. By tiling 
these two programs, you can easily open new images into iPhoto Express by simply dragging them from Explorer.



Acquire Image dialog box
    Destination
    Post Processing

Automatically correct the scanned image for common problems that occur during the scan.
Auto straighten Correct the image if it appears slanted by using predominant horizontal 

or vertical lines in the image as references.
Auto crop Remove apparently unnecessary space from the outer edges of the image.
Auto-remove moiré Smooth out patterns in solid colored areas of the image to produce a

more uniform look.
Add frame & shadow Add a border and shadow, or background to the scanned image.
Setup frame & shadow Click to change or review the current settings for adding a frame 

or shadow to the scanned image.
Acquire Start scanning.



Customize dialog box
Determine the number of rows and columns for the printed page and the size of each block.

Row and Column Enter the desired number of rows and columns that should contain 
images for the page.

Dimensions Enter the amount of extra space to add around to each edge of a tile. The X 
setting adds the specified amount to the left and right sides of the image; Y to the top and bottom. Make sure that the 
dimensions you enter do not cause the total width or height for all tiles to exceed the printable area of the page.

Keep original size Check to prevent iPhoto Express from resizing the image to fit the tile 
according to the Row, Column, and Dimensions settings. When checked, if the entire page will not be filled by image 
data, the printed tiles are centered in the page with extra space around the edges.



    Print Preview Options Menu
Cutting Grid Check to print a dotted line where sheets should be connected.
Layout Choose to open the Layout dialog box. Here you can resize the image and set 

margins for the printed page.
Select Pages Choose which parts of the image to print based upon which page that 

portion of the image appears.

     Print Preview View Menu
Actual View Resize the preview to the largest size that will fit the window.
Zoom In Take a closer look at the image.
Zoom Out View more of the page.
Inch Show dimensions in inches.
Cm Show dimensions in centimeters.



    Print Preview Options Menu
Fit as many as possible Check to automatically determine and arrange the maximum 

number of images that can be evenly distributed on the page.
Customize Choose to specify the desired number of images and spacing between each 

image. The Customize dialog box opens where you can define how many rows and columns of images to print and 
how far apart they are.

     Print Preview View Menu
Actual View Resize the preview to the largest size that will fit the window.
Zoom In Take a closer look at the image.
Zoom Out View more of the page.
Inch Show dimensions in inches.
Cm Show dimensions in centimeters.
Ruler Show a ruler at the top and left edges of the page. (The ruler does not print out.)



Bucket and Gradient Fill Tool Options
Color Click to choose a color for the fill.
Similarity Determine the range of colors to include in when creating the selection. For 

example, if you set the similarity to 32, and click on a pixel with a value of 128,0,128 (dark magenta), all pixels with 
values in the range of 96,0,96 to 160,32,160 will be replaced by the resulting fill. Note: iPhoto Express treats negative
values as 0 or and those higher than 255 as 255. (Bucket fills only)

How Select how you wish the fill to progress. (Gradient fills only)
Transparency Set the transparency to a higher value to allow more of the underlying 

image to show through the fill.



Clone and Paint Tool Options
Shape Choose the shape and size for the brush you use to paint colors or effects. These 

shapes are available:
    Square,      
    Circle,      
    Horizontal Line,      

    Vertical Line,      
    Left Diagonal,      
    Right Diagonal

Note: The Crayon does not allow you to choose a shape.
Color Click to choose a color to paint. This is not available for the Clone tool.
Transparency Set the transparency to a higher value to allow more of the underlying 

image to show through the changes you paint onto the image.
Soft Edge Set a higher value to blend the edges of the changes you paint into the image 

more smoothly into the background. When setting the soft edge values, be careful not to set a size that is larger than 
the actual size of the change you paint.

Distribution Set a higher value reduce the density of the colored lines you draw. Colored 
pixels are further apart.

Pressure Set a higher value to make the color darker. This is similar to pushing down 
harder on the paper with the crayon.

Options Choose the type of line you wish to add. You may choose from freehand, straight
lines, or connected lines. If you choose Connected lines, double-click to close the shape. Note: The Clone tool does 
not offer line drawing options.



Send dialog box
Prepare a message to send along with an image from iPhoto Express.

Subject Enter the subject to include in the message header. This will let your recipients 
know what the message is about before they open and read the message.

Message Enter the message you wish to send in the e-mail.
Image file Check to include the current image file with the message as an attachment. 
OK Accesses the Choose Profile dialog box for addressing the message. 

Note: You may use the Send dialog box to send any combination of images and text.



Preferences dialog box
    iPhoto Express
    Associate
    Memory
    Display
    Photo CD

Optimize how Windows manages system memory while running Ulead programs.
Measurement unit Choose the measurement you want to show when displaying a ruler in

the workspace.
Enable undo Check to have iPhoto Express keep track of what you do so you can go 

back to correct mistakes. Enter the number of steps you want the program to check in the Levels of Undo text box 
(maximum of 5).

Number of recently opened files Enter the number of filenames you want iPhoto 
Express to keep track of in the Recently Opened Files list at the bottom of the File menu (up to 9).

Generation quality Choose Best to have iPhoto Express draw lines and create certain 
effects very carefully to produce the most realistic results. Choose Good to work faster.

Display confirmation message when saving Check this to have iPhoto Express warn 
you if elements in your image may be lost or changed when you save your image. This can happen if you save the 
image to a lossey format, such as JPEG or if there are floating selections in your image when you save.

Show tips at startup Check to have iPhoto Express start with a tip to help you work more
effectively. A different tip shows each time you start with useful advice, hints, or secrets about getting the most out of 
iPhoto Express.

Automatically change groups after opening a photo Check to have iPhoto Express 
automatically change to the Adjust group after you load a photo into the workspace.

Task bar scroll speed Set to a higher value to scroll the bar faster.



Replace Photo Options
Click a command to choose how to replace the selected photo in a template:

Open from file Click to use a previously saved image on your hard disk, CD, or diskette. 
iPhoto Express Explorer allows you to search for and select an image.

Scan Click to scan an image directly into the placeholder from your scanner, digital 
camera, or other connected TWAIN device.

Paste from clipboard Click to use an image that you copied to the clipboard.
Import Click to use your bring an image in directly from your connected video capture 

device.



Global Viewer
Allows you to quickly move to another area in the image when the current magnification is too large to allow the entire
image to fit in the window. Click to see a thumbnail view of the image and drag the bounding box in the thumbnail to 
the area you wish to see.




